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After completing this lesson, you will be able to:
1. Start Excel.

2. Navigate in a workbook.

3. Open an existing workbook.

4. Edit a worksheet.

5. Manage files.

6. Print Excel files.

Microsoft Excel is electronic spreadsheet software. You can use Excel to create 
professional reports that perform business or personal calculations, display 
financial or scientific calculations, complete table management tasks, and 
show charts. Excel is powerful but easy to use. You’ll become a productive 
Excel user as soon as you learn the basics.

Starting Excel
Excel opens showing a blank workbook, the Microsoft Office Button, the 
Quick Access toolbar, and the Ribbon (see Figure 1-1). New workbooks 

are named Book1, Book2, and so on during each work 
session.

The Ribbon is a set of command tabs. Each command 
tab has buttons, galleries, or other controls related to 
a specific task group or object. Some command tabs 
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Figure 1-1
Excel screen

TABLE 1-1 Parts of the Excel Screen

Part of Screen Purpose

Active cell  The cell outlined in a heavy black border. It is ready to accept new data, a 
formula, or your edits.

Column headings  Alphabetic characters across the top of the worksheet that identify columns.

Command tabs  A Ribbon tab control with command buttons, galleries, and other controls 
for creating, managing, editing, and formatting data.

Formula bar  Displays the contents of the active cell. You can also enter text, numbers, or 
formulas in the formula bar. It can be expanded and collapsed as needed.

Microsoft Office Button  Opens a menu with basic commands for working with the document.

Name Box  A drop-down combo box that shows the address of the active cell. You can 
also use it to move the pointer to a specific location.

Quick Access toolbar Toolbar with shortcut command buttons for common tasks.

Ribbon Organizes and displays command tabs.

Row headings Numbers down the left side of the worksheet that identify rows.

Scroll bars Used to move different parts of the screen into view.

Status bar  Displays information about the current task and mode of operation as well  
as View choices and the Zoom control.

Tab scrolling buttons Navigation buttons to scroll through worksheet tabs.

Title bar Contains the program name and the name of the workbook.

View switcher  Buttons to change the view of the current sheet among Normal, Page 
Layout, and Page Break Preview.

Worksheet tabs  Indicators at the bottom of the worksheet to identify sheets in the workbook.

Zoom controls Buttons and slider to change the view magnification.

Tab 
scrolling 
buttons

View 
switcher

Microsoft 
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Ribbon

Zoom 
slider and 
buttons

Vertical scroll bar

Quick Access toolbar

Command tab
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are context-sensitive and appear only when needed to 
accommodate what you are doing. The Quick Access toolbar 
provides one-click access to frequently used commands. 
You can add command buttons to this toolbar, and you can 
reposition it below the Ribbon. The Microsoft Office Button 
replaces the File menu in previous versions of Office, but it 
still lists commands such as Save and Print.

Exercise 1-1 WORK WITH THE EXCEL INTERFACE

There are several ways to start Excel, depending on how your software is 
installed. You can use the Start button on the Windows taskbar to choose 
Excel from the list of available programs. There may be an Excel icon on the 
desktop that you can double-click to start Excel.

Your screen size and resolution affects how the command buttons look 
and how much you see at once. Do not be concerned if your screen looks 
slightly different from illustrations in this text.

When the instructions tell you to “click” a tab, a command button, or a 
menu option, use the left mouse button. Use the left mouse button to carry 
out commands unless you are told explicitly to use the right mouse button.

 1. Start Excel. A blank workbook opens.

 2. Click the Home tab in the Ribbon. Commands on this tab are 
organized into seven groups: Clipboard, Font, Alignment, Number, 
Styles, Cells, and Editing.

3.  In the Font group, rest the mouse pointer on the Bold 
button . A Super ScreenTip includes the button 
name, a brief description of the button’s function, 
and its keyboard shortcut.

4.  In the Font group, rest the mouse pointer on the 
Dialog Box Launcher. A Super ScreenTip describes 
and previews the dialog box that will be opened 
when you click this button. Many command groups 
have a Dialog Box Launcher.

NOTE

Super ScreenTips explain the purpose of 
the button, provide a keyboard shortcut, 

and when appropriate, describe when you 
might use the feature. They might also 

include a thumbnail image of a dialog box 
to be opened.

NOTE

Windows provides many ways to start 
applications. If you have problems, ask 

your instructor for help.

Give students time to review 
a Windows Vista tutorial if 
they need general Windows 
practice. Show/tell students 
how to start Excel in the 
classroom.

The new user interface can 
be cumbersome to students 
with prior Office experience. 
They will become more 
comfortable with the new 
interface as they move 
through the lessons. Check 
display settings on classroom 
computers to determine how 
students’ screens may differ 
from text figures.
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 5. Click the Dialog Box Launcher for the Font group. The Format Cells 
dialog box opens with the Font tab visible.

 6. Click Cancel to close the dialog box.

 7. Click the View tab in the Ribbon. Commands on this tab are 
organized into five groups: Workbook Views, Show/Hide, Zoom, 
Window, and Macros.

  8.  In the Workbook Views group, move the mouse 
pointer to Full Screen  and click. A Full 
Screen view shows only worksheet cells with row 
and column headings.

  9. Press Esc  on the keyboard to return to normal view.

10.  Click the Page Layout View button . This view is 
an interactive preview of how the page will print 
and shows margins, the ruler, and header/footer 
areas. The grid does not print.

11. Click the Normal button .

12.  Press and release the Alt  key. KeyTips appear over a 
command name when you press the Alt  key. They 
show keyboard shortcuts.

13. Key h to activate the Home tab.

 14. Press Tab  four times. The active task cycles through the commands 
in the Clipboard group, and the KeyTips are no longer visible. The 
Clipboard group is now active.

 15. Press Esc .

 16. Press F10  and key h. This is another keyboard shortcut to display 
KeyTips. Each task now shows a key.

Figure 1-2
Dialog Box Launcher 
for the Font group

NOTE

The Esc  key is at the top left of most 
keyboards.

NOTE

When KeyTips are visible, press Tab  or an 
arrow key to move through the tasks.

c

PP: Excel Classroom 
Presentation 1.c
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TABLE 1-2 Navigation Commands in a Workbook

Press To Do This

Ctrl � Home  Move to the beginning of the worksheet.

Ctrl � End  Move to the last used cell on the worksheet.

Home  Move to the beginning of the current row.

PageUp  Move up one screen.

PageDown  Move down one screen.

Alt � Page Up  Move one screen to the left.

Alt � Page Down  Move one screen to the right.

, , ,  Move one cell up, down, left, or right.

Ctrl �arrow key Move to the edge of a group of cells with data.

Ctrl � G  or F5  Open the Go To dialog box.

Click Move to the cell that is clicked.

Tab  Move to the next cell in a left-to-right sequence.

Shift � Tab  Move to the previous cell in a right-to-left sequence.

Ctrl � Backspace  Move to the active cell when it has scrolled out of view.

Ctrl � Page Up  Move to the previous worksheet.

Ctrl � PageDown  Move to the next worksheet.

17. Key 1 to turn on bold. You can see that bold is applied by the button 
color.

18.  Click the Bold button . Bold is toggled off.

19.  Double-click the Home tab. The ribbon collapses 
and more working space is available.

20.  Right-click the Home tab. Click to deselect Minimize 
the Ribbon. You can right-click any tab to expand 
or collapse the ribbon.

Navigating in a Workbook
A workbook is the file Excel creates to store your data. When you look at 
the screen, you are viewing a worksheet. A worksheet is an individual page 
or sheet tab. A new workbook opens with three blank worksheets. You can 
insert or delete worksheets in the workbook. A workbook must have at least 
1 worksheet and can have as many as your computer’s memory allows.

 OBJECTIVE 2 OBJECTIVE 2

TIP

The keyboard shortcut to collapse/expand 
the ribbon is Ctrl � F1 .

Objective 2 Assignment:
Exercises 1-18 (Skills Review) and 1-26 (On Your 
Own) can be assigned after completing Objective 2.
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NOTE

In a cell address, the column letter is first.

NOTE

Pointing and resting the mouse pointer 
on a button is known as “hovering.”

NOTE

Cell A1 is the active cell on all three 
worksheets in a new workbook.

NOTE

When keyboard combinations (such as 
Ctrl � Page Up ) are shown in this text, 

hold down the first key without releasing 
it and press the second key. Release the 

second key and then release the first key.

A worksheet is divided into rows and columns. The rows are numbered 
and reach row 1,048,576. There are 16,384 columns, lettered from A to Z, 
then AA to AZ, BA to BZ, AAA to AAZ, ABA to ABZ, and so on, up to column 
XFD.

The intersection of a row and a column forms a 
rectangle known as a cell. You enter data (text, a number, 
or a formula) in a cell. Cells have cell addresses or cell 
references, which identify where the cell is located on the 
worksheet. Cell B2, for example, is the cell in column B, 
row 2.

The active cell is the cell that appears outlined with a thick border. It is 
ready to accept data or a formula, or if it already contains data or a formula, 
it is ready to be modified. It is the cell in which you are currently working. 

When you open a new workbook, the active cell is cell A1, 
the top-left cell in the worksheet. Cell A1 is referred to as 
“Home.”

The mouse pointer displays as a thick white cross when 
you move it across cells in the worksheet. When you point 
at a Ribbon or worksheet tab, a command button, or a 
menu item, the pointer turns into a white arrow.

Exercise 1-2 MOVE BETWEEN WORKSHEETS

A new workbook has three worksheets named Sheet1, 
Sheet2, and Sheet3. Sheet1 is displayed when a new 
workbook is opened.

 1.  Click the Sheet2 worksheet tab. You can tell which 
sheet is active because its tab appears more white 
and the tab name is bold.

 2.  Click the Sheet3 worksheet tab. All three sheets are 
empty.

 3.  Press Ctrl � Page Up . This shortcut moves to the 
previous worksheet, Sheet2, in this case.

 4.  Press Ctrl � Page Down . This command moves to the 
next worksheet, Sheet3.

 5. Click the Sheet1 tab to return to Sheet1.

Exercise 1-3 GO TO A SPECIFIC CELL

When you move the mouse pointer to a cell and click, the cell you clicked 
becomes the active cell. It is outlined with a black border, and you can see 
the cell address in the Name Box. The Name Box is a drop-down combo box 
at the left edge of the formula bar. You can also determine the cell address by 
the orange-shaded column and row headings.

Illustrations in this text 
show the Blue color scheme 
(Microsoft Office Button, 
Excel Options, Popular).
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 2.  Press Ctrl � Home . This shortcut makes cell A1 
the active cell.

 3. Press Ctrl � G  to open the Go To dialog box.

 4.  Key b19 in the Reference box and press Enter . Cell 
B19 becomes the active cell, and its address is 
shown in the Name Box.

Figure 1-4
Go To dialog box

TIP

As an alternative, open the Go To dialog 
box by clicking the Find & Select button 

 in the Editing group on the Home tab 
and choosing Go To.

 1.  Move the mouse pointer to cell D4 and click. Cell D4 is the active 
cell, and its address appears in the Name Box. The column D and 
row 4 headings are shaded.

Figure 1-3
Active cell showing a 

thick border

Name Box

Shaded column
heading

Shaded row
heading

c

c

Note: Tell students that Excel capitalizes cell references in 
commands, and they can save time by keying lowercase letters.

PP: Excel Classroom 
Presentation 1.c
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 5. Press Ctrl � G . Recently used cell addresses are listed in the Go to list 
in the Go To dialog box.

 6. Key c2 and click OK.

 7. Click in the Name Box. The current cell address is highlighted.

 8. Key a8 in the Name Box and press Enter .

Figure 1-5
Using the Name Box

 9. Press Ctrl � Home  to return to cell A1.

Exercise 1-4 SCROLL THROUGH A WORKSHEET

When you scroll through a worksheet, the location of the active cell does 
not change. Instead, the worksheet moves on the screen so that you can see 
different columns or rows. The number of rows and columns you see at once 
depends on screen resolution and the Zoom size in Excel.

 1.  On the vertical scroll bar, click below the scroll box. The worksheet 
has been repositioned so that you see the next group of about 
20 to 30 rows.

 2.  Click above the vertical scroll box. The worksheet has scrolled up to 
show the top rows.

 3.  Click the right scroll arrow on the horizontal scroll bar once. The 
worksheet scrolls one column to the right.

 4. Click the left scroll arrow once to bring the column back into view.

c

PP: Excel Classroom 
Presentation 1.c
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NOTE

You cannot see the active cell (cell A1) 
during your scrolling.

Figure 1-6
Using scroll bars

TABLE 1-3 Scrolling Through a Worksheet

To Move the View Do This

One row up Click the up scroll arrow.

One row down Click the down scroll arrow.

Up one screen Click the scroll bar above the scroll box.

Down one screen Click the scroll bar below the scroll box.

To any relative position Drag the scroll bar up or down.

One column to the right Click the right scroll arrow.

One column to the left Click the left scroll arrow.

 5.  Click the down scroll arrow on the vertical scroll bar 
twice.

 6.  Drag the vertical scroll box to the top of the vertical 
scroll bar. As you drag, a ScreenTip displays the row 
number at the top of the window. During all this 
scrolling, the active cell is still cell A1.

Up scroll arrow

Vertical scroll box

Down scroll arrow

Right scroll arrow

Horizontal scroll box

Left scroll arrow

c

PP: Excel Classroom 
Presentation 1.c
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Exercise 1-5 CHANGE THE ZOOM SIZE

The Zoom size controls how much of the worksheet you see on the screen. 
You can set the size to see more or less on screen and reduce the need to 
scroll. The 100% size shows the data close to print size. A Zoom slider and 
two buttons are at the right edge of the status bar.

 1.  Click the Zoom In button  on the status bar. The worksheet is 
resized to 110% and you see fewer columns and rows.

Figure 1-7
Changing the Zoom 

size

 2.  Click the Zoom Out button . The worksheet is reduced to 100% 
magnification.

 3.  Click the Zoom Out button  again. Each click changes the 
magnification by 10%.

 4.  Point at the Zoom slider button , hold down the mouse 
button, and drag the slider slowly in either direction. You can set 
any magnification size.

 5.  Click the View tab in the Ribbon. There is a Zoom button  on 
this tab.

 6.   Click the Zoom button . The Zoom dialog box 
opens.

 7. Choose 200%. Click OK.

 8. Click 200% in the status bar. The dialog box opens.

 9. Choose 100% and click OK.

TIP

It is usually quicker to change magnification 
by using the Zoom tools on the status bar.

Zoom InZoom sliderZoom Out

The size of the screen, the display 
settings, the data, and its formatting 
affect how many columns/rows appear 
at once. Remind students about 
differences between their screens and 
text illustrations.

c

PP: Excel Classroom 
Presentation 1.c
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Exercise 1-6 CLOSE A WORKBOOK

After you finish working with a workbook, you should save your work and 
close the workbook. You can close a workbook in several ways.

 Click the Microsoft Office Button  and choose Close.

 Click the Close Window button  at the right end of the Ribbon tabs.

Use keyboard shortcuts, Ctrl �W  or Ctrl � F4 .

 1. Click the Microsoft Office Button .

 2.  Choose Close. (If you have made a change to the workbook, a 
dialog box asks if you want to save the changes. Click No if this 
message box opens.) The workbook closes, and a blank blue screen 
appears.

Opening an Existing Workbook
There are several ways to open an existing workbook.

Click the Microsoft Office Button  and choose Open.

Use the keyboard shortcut Ctrl � O  or Ctrl � F12 .

 Navigate through folders in Windows Explorer or Computer to find 
and double-click the filename.

Exercise 1-7 OPEN A WORKBOOK

 1.  Click the Microsoft Office Button  and choose Open. The 
navigation line shows the most recently used folder.

 2. Choose the drive/folder according to your instructor’s directions.

 3.  Click the arrow next to the Organize button  
and hover over Layout.

 4.  Click to select Details Pane. The Details pane is at 
the lower part of the dialog box. (Navigation Pane 
should also be selected. If it is not, repeat these 
steps to select it.)

 5.  Click the arrow next to the Views button  and choose Small 
Icons.

•

•

•

•

•

•

 OBJECTIVE 3 OBJECTIVE 3

NOTE

Your instructor will advise you on the 
drive/folder to use for this course.

Show/tell students where and how data files are 
stored. Demonstrate how to change the layout 
of the Open dialog box. Highlight differences in 
the appearance of the Computer dialog box, an 
Explorer window, and the Open dialog box.
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 6.  Find and click JanIceCream. The Details pane 
shows a thumbnail of the document.

 7. Double-click JanIceCream. The workbook opens.

Editing a Worksheet
The JanIceCream workbook has three worksheets. The worksheets have 
been renamed WeeklySales, Owners, and Chart to better indicate what is on 
the sheet. For instance, the WeeklySales sheet shows sales for each city in 
each of the four weeks in January.

Worksheet cells contain text, numbers, or formulas. A formula calculates 
an arithmetic result. By simply viewing the worksheet, you might not know 
if the cell contains a number or a formula. However, you can determine a 
cell’s contents by checking the formula bar. You can also use the formula bar 
to change the contents of cells.

 OBJECTIVE 4 OBJECTIVE 4

Figure 1-8
Open dialog box

NOTE

The workbooks in this course relate to the 
Case Study about Klassy Kow Ice Cream, 
Inc., a fictional manufacturer of ice cream 

(see Case Study in the frontmatter).

Navigation pane

Details pane

PP: Excel Classroom 
Presentation 1.c Point out that filenames in the Open 

dialog box show a ScreenTip when you 
hover over the name. If a workbook 
opens in a 100% size and students 
cannot see all, they can try a smaller 
Zoom size.

c

Objective 4 Assignment:
Exercises 1-19 and 1-20 (Skills Review) 
can be assigned after completing 
Objective 4.
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Exercise 1-8  VIEW WORKSHEETS AND 
CELL CONTENTS

 1.  Click the Owners worksheet tab. The Owners worksheet shows the 
city and the name of the shop owner.

 2.  Click the Chart tab. This bar chart illustrates January sales for each 
city.

 3.  Press Ctrl � Page Up . This moves to the Owners worksheet.

 4.  Press Ctrl � Page Down . Now, the active tab is the 
Chart sheet.

 5. Click the WeeklySales tab.

 6. Press F5  to open the Go To dialog box.

 7.  Key a5 and press Enter . The active cell is changed 
to cell A5. This cell contains the name of a city 
(Auburn), which you can see in the formula bar and 
on the worksheet.

REVIEW

If you cannot see column F or row 
19, adjust the Zoom size.

Figure 1-9
JanIceCream.xlsx

WeeklySales sheet
Cell contents and the 

formula bar

Active cell

Formula bar

PP: Excel Classroom 
Presentation 1.c

c
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 8.  Press F5 , key c10, and press Enter . Cell C10 contains a number. In the 
formula bar, the number does not show the comma.

 9.  Press F5 , key f17, and press Enter . Cell F17 contains a formula, which 
you can see in the formula bar. Formulas calculate a result.

Exercise 1-9 REPLACE CELL CONTENTS

When the workbook is in Ready mode, you can key, edit, or replace the 
contents of a cell. To replace a cell’s contents, make it the active cell, key 
the new data, and press Enter . You can also click the Enter button  in 
the formula bar or press any arrow key on the keyboard to complete the 
replacement.

If you replace a number used in a formula, the result of the formula 
automatically recalculates when you complete your change.

 1. Click cell B5 to make it the active cell.

 2.  Key 20000 without a comma. As you key the number, it appears 
in the cell and in the formula bar. The status bar shows Enter to 
indicate that you are in Enter mode.

Figure 1-10
JanIceCream.xlsx

WeeklySales sheet
Replacing cell 

contents

Mode indicator

Enter button
Contents of the active cell

c

Ask students to determine what the 
formula calculates.

Explain that commas are part of the 
formatting for a number in this worksheet.

PP: Excel Classroom 
Presentation 1.c
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 3.  Press Enter . Excel inserts a comma, and the next cell in column B is 
active. The “Store Total” (cell F5, 60,500) and the “California Weekly 
Totals” amounts (in cells B18 and F18, 245,000 and 947,000) are 
recalculated. The worksheet returns to Ready mode.

 4.  Press  to move to cell B5. Key 10000 without a 
comma. Click the Enter button  in the formula 
bar. Notice that when you use the Enter button , 
the pointer stays in cell B5.

 5.  Click the Chart tab. Notice the length of the Auburn 
bar, showing sales near $50,000.

 6. Click the WeeklySales tab.

 7.  In cell B5, key 0, and press Ctrl � Enter . A zero appears 
as a short dash in this worksheet.

 8.  Click the Chart tab. The chart on this worksheet is 
based on the data in the WeeklySales worksheet. Now 
that you have reduced sales, the Auburn bar is shorter.

 9.  Click the WeeklySales tab and key 10000 in cell B5. Press .

Exercise 1-10 EDIT CELL CONTENTS

If a cell contains a long or complicated entry, you can edit it rather than 
rekeying the entire entry. Edit mode starts when you:

Double-click the cell.

Click the cell and press F2 .

 Click the cell and then click anywhere in the formula bar.

•

•

•

NOTE

Ctrl � Enter  keeps the insertion point in 
the current cell.

TIP

Commas are part of the cell format in this 
worksheet.

TABLE 1-4 Keyboard Shortcuts in Edit Mode

Key To Do This

Enter   Complete the edit, return to Ready mode, and move the insertion point to the next cell.

Alt � Enter  Move the insertion point to a new line within the cell, a line break.

Esc  Cancel the edit and restore the existing data.

Home  Move the insertion point to the beginning of the data.

End  Move the insertion point to the end of the data.

Delete  Delete one character to the right of the insertion point.

Ctrl � Delete  Delete everything from the insertion point to the end of the line.

Backspace  Delete one character to the left of the insertion point.

 or  Move the insertion point one character left or right.

Ctrl �  Move the insertion point one word left.

Ctrl �  Move the insertion point one word right.

Automatic Calculation is toggled on/off on the Formulas pane of Excel 
Options (Microsoft Office Button).
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 1.  Click cell A2. The text in cell A2 is long, and its 
display overlaps into columns B and C.

 2.   Press F2 . Edit mode is shown in the status bar. 
An insertion point appears in the cell at the end of 
the text.

 3.  Double-click “Data” in the cell. A Mini toolbar 
appears with buttons for font editing.

  4.  Point at the Mini toolbar. Its appearance brightens for easy viewing.

TIP

In Edit mode, double-clicking highlights 
or selects a word.

Figure 1-11
JanIceCream.xlsx

WeeklySales sheet
Using Edit mode

Mode indicator

Mini toolbar

c

PP: Excel Classroom Presentation 1.c
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 5. Key Information. It replaces the word “Data.” The Mini toolbar has 
disappeared.

 6. Press Enter  to complete the edit. Pressing Enter  does not start a new 
line in the cell when the worksheet is in Edit mode.

 7. Double-click cell A3. This starts Edit mode, and an insertion point 
appears in the cell.

 8. In the cell, click to the left of the first  “S” in “Shops.”

 9. Key Retail and press Spacebar . Press Enter .

 10. Click cell F1. There is nothing in this cell.

 11. Key your first name, a space, and your last name in the cell. Press 
Enter . If your name is longer than column F, part of its display might 
overlap into column G and even into column H.

Exercise 1-11 CLEAR CELL CONTENTS

When you clear the contents of a cell, you delete the text, number, or formula 
in that cell.

 1.  Click cell B5. Press Delete  on the keyboard. The 
number is deleted, and Excel recalculates the 
formula results in cells F5, B18, and F18.

 2. Press  to move the pointer to cell C5.

 3.  On the Home tab in the Editing group, click the Clear 
button .

 4.  Choose Clear Contents. The number is deleted, and 
formulas are recalculated.

Exercise 1-12 USE UNDO AND REDO

The Undo command reverses the last action you performed in the worksheet. 
For example, if you delete the contents of a cell, the Undo command restores 
what you deleted. The Redo command reverses the action of the Undo 
command. It “undoes” your Undo.

To use the Undo command, you can:

 Click the Undo button  on the Quick Access toolbar.

Press Ctrl � Z  or Alt � Backspace .

•

•

NOTE

A green triangle may appear in the 
corners of cells F5 and B18 to indicate 

that a formula error has occurred. Ignore 
the triangles for now.

Error indicators display if the option 
to show formulas that refer to empty 
cells has been selected (Microsoft 
Office Button, Excel Options, Formulas, 
Error checking rules).

Students may notice that an empty cell 
does not show the dash that they saw 
earlier for a zero. Explain that zero and 
empty are not the same.



UNIT 1 Introduction to Excel
Excel 2007

19

To use the Redo command, you can:

 Click the Redo button  on the Quick Access toolbar.

 Press Ctrl � Y  or F4 .

Excel keeps a history or list of your editing commands, and 
you can undo several at once.

 1.  Click the Undo button . The number in cell C5 is 
restored.

 2.  Click the Redo button . The number is cleared 
again.

 3. Click cell A8 and key Gotham. Press Enter .

 4. In cell A9 key Los Angeles and press Enter .

 5.  Click the arrow next to the Undo button  to 
display the history list.

 6.  Move the mouse to highlight the top two actions 
and click. The last two changes are undone, and the 
original city names are restored.

•

•

Figure 1-12
JanIceCream.xlsx

WeeklySales sheet
Undoing multiple 

edits

NOTE

The ScreenTip for the Undo button 
includes the most recent task, such as 

Undo Clear.

NOTE

Depending on the actions that have been 
undone and redone on your computer, 

your list might be different from the one 
shown in Figure 1-12.

PP: Excel Classroom 
Presentation 1.c
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 7.  Click the Redo button . The first action is 
restored.

 8. Click the Redo button  again.

 9. Press Ctrl � Home  to place the pointer in cell A1.

Managing Files
Workbook files are usually stored in folders. A folder is a location on a disk, 
network, or other drive. Folders are organized in a structure like a family 
tree. The top level of the tree is a letter such as C, F, or G to represent the disk 
or other storage device. Under each letter, you can create folders to help you 
organize and manage your work.

For your work in this text, you will save your files in a folder you create 
for each lesson.

Exercise 1-13  CREATE A NEW FOLDER 
AND USE SAVE AS

 1.  Click the Microsoft Office Button  and choose 
Save As. The Save As dialog box opens. You will 
save JanIceCream with a new filename in a lesson 
folder.

 2. Choose the drive and folder location for your work.

 3.  Click the New Folder button . A New Folder icon opens.

 4.  Key [your initials]Lesson1. Press Enter . Your new folder’s name now 
appears in the navigation line.

 5.  In the File name box, make sure the filename 
JanIceCream is highlighted or selected. If it is not 
highlighted, click to select it.

TIP

If you place the pointer in cell A1 when 
you save a workbook, cell A1 is the 

active cell the next time you open the 
workbook.

 OBJECTIVE 5

NOTE

Ask your instructor where to save lesson 
folders for this course.

NOTE

JanIceCream may be a read-only file 
if you opened it from a protected or 

restricted location. You cannot resave 
such a file with its existing filename.

Tell students what drive/
folder to use for their work 
folders.

Explain the Read-only 
property for files opened 
or copied from a protected 
source.

Objective 5 Assignment:
Exercise 1-28 (On Your 
Own) can be assigned after 
completing Objective 5.
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Printing Excel Files
You can use any of these methods to print a worksheet:

Press Ctrl � P .

 Click the Microsoft Office Button  and choose Print and then Quick 
Print.

Click the Print button  while in Print Preview.

 Click the Quick Print button  on the Quick Access toolbar.

•

•

•

•

 OBJECTIVE 6 OBJECTIVE 6

Figure 1-13
Save As dialog box

NOTE

Excel automatically assigns the .xlsx 
extension to files you save, but your 
computer may not be set to display 

filename extensions.

 6.  Key [your initials]1-13 and click Save. Your new filename now 
appears in the title bar.

c

PP: Excel Classroom 
Presentation 1.c Objective 6 Assignment:

Exercises 1-21 (Skills Review); 1-22, 1-23, 1-24, and 1-25 (Lesson 
Applications); and 1-27 (On Your Own) can be assigned after 
completing Objective 6.
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Some methods open the Print dialog box, in which you can change 
printing options. The Quick Print button , if it is on the Quick Access 
toolbar, and choosing Quick Print from the menu send the worksheet to the 
printer with default print settings.

Page Layout View displays your sheet with margin and header/footer 
areas. You can edit your work in Page Layout View. Print Preview also shows 
your worksheet as it will print in a normal or reduced view. You cannot make 
any changes in Print Preview.

Exercise 1-14 PREVIEW AND PRINT A WORKSHEET

 1.  In the status bar, click the Page Layout View button . The page 
shows margin areas and the rulers.

 2.  Click the Zoom Out button  in the status bar. The worksheet is 
reduced to 90% magnification.

 3.  Click the Zoom Out button  to reach 50% magnification. Unused 
pages appear grayed out.

 4. Click 50% in the status bar. Choose 100% and click OK.

 5. Click the Normal button  in the status bar.

 6.  Click the Microsoft Office Button  and hover over Print. A 
submenu opens.

 7.  Choose Print Preview. The worksheet is shown in a reduced size so 
that you can see the entire page.

Figure 1-14
1-13.xlsx

WeeklySales sheet
Worksheet in Print 

Preview

You may want to show students how to add the Quick Print button to the Quick Access toolbar. Click the 
Customize Quick Access Toolbar arrow and choose Quick Print.

PP: Excel Classroom 
Presentation 1.c
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 8. Move the mouse pointer near the main headings. The pointer 
appears as a small magnifying glass icon.

 9. Click while pointing at the headings. The worksheet changes to a 
larger size, close to the actual print size.

10.  Click anywhere to return to a reduced size. The 
mouse pointer appears as a white solid arrow when it 
will zoom out.

11.  Zoom in on the “California Weekly Totals” row. 
Click anywhere to zoom out.

12.  Click the Print button . The Print dialog box opens.

 13. Press Enter . A printer icon appears on the taskbar as the worksheet is 
sent to the printer. Only the WeeklySales worksheet is printed.

Exercise 1-15 PRINT A WORKBOOK

You can print all sheets in a workbook with one command from the Print 
dialog box.

 1. Press Ctrl � P . The Print dialog box opens with your default settings.

Figure 1-15
Print dialog box

NOTE

Changing the size in the Print Preview 
window is called zooming in and out.

 2. In the Print what section, choose Entire workbook.

c

Show students how to check and 
change printer settings in the 
classroom.

PP: Excel Classroom 
Presentation 1.c



UNIT 1 Introduction to Excel
Ex

ce
l 2

00
7 24

 3.  Click Preview. The reduced size shows the first page, the WeeklySales 
sheet. The status bar shows that this is page 1 of 3.

 4. Press Page Down . This is the second sheet, the Owners worksheet.

 5.  Press Page Down . This is the Chart sheet. It is set to print in landscape 
orientation.

 6. Click Previous Page two times to return to the first sheet.

 7.  Click the Print button . All three sheets are sent to the printer and 
Print Preview closes.

Exercise 1-16 SAVE AN XPS FILE

XPS is XML Paper Specification (XPS), a file type that maintains document 
formatting so that you or others can view or print the worksheet exactly as it was 
designed, with or without Excel. You need a viewer to open an XPS document, 
available in Windows Vista or free from Microsoft’s Web site. To save a file as an 
XPS (or PDF) document, you must have installed this add-in at your computer.

 1.  Click the Microsoft Office Button  and choose Save As. The Save 
As dialog box opens. If you have opened the Publish as PDF or XPS 
dialog box, close it and try again.

 2. Choose [your initials] Lesson1 as the location.

 3.  In the File name box, make sure the filename [your initials]1-13 is 
highlighted or selected. If it is not highlighted, select it.

 4. Key [your initials]1-16.

 5.  Click the Save as type arrow. A list of file types 
opens.

 6.  Find and choose XPS Document. The same document 
name is assumed, but it will have a different 
extension.

 7.  Choose Standard as the Optimize for option. Click to deselect Open 
file after publishing.

 8.  Click Options and choose Entire workbook in the Publish what group. 
Click OK (see Figure 1-16).

 9.  Click Save. Your workbook is still open, and the XPS file is saved 
separately.

TIP

You can also save a document as an 
Adobe PDF file so that others can view it 

without Excel.

Make sure students 
understand portrait 
and landscape print 
settings.

Discuss how you want 
students to submit work. The 
Save as PDF and XPS add-ins 
must be installed for students 
to complete this exercise. 
Talk about XPS format and the 
need for a viewer. Compare it 
to Adobe’s PDF format.

If students choose PDF or XPS from 
the Save As submenu, the Publish 
as PDF or XPS dialog box opens. 
This dialog box is different from the 
Save As dialog box but does include 
the same information. Check this at 
classroom computers.
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Exercise 1-17 EXIT EXCEL

You can exit Excel and close the workbook at the same time. If you give the 
command to exit Excel, you will see a reminder to save the workbook if you 
have not yet done so.

There are several ways to close a workbook and exit Excel:

Click the Microsoft Office Button  and choose Exit Excel.

 Use the Close button  to first close the workbook and then to close 
Excel.

Use the keyboard shortcut Alt � F4  to exit Excel.

 1. Click the Microsoft Office Button .

 2. Choose Exit Excel. Do not save changes if asked.

Using Online Help
Online Help is available at your computer and on the Microsoft Office Web 
site. An easy way to use Help is to key a short request in the search text box 
at the top of the opening screen.

•

•

•

Figure 1-16
Saving an XPS 

document

PP: Excel Classroom 
Presentation 1.c Encourage students to follow the steps in “Using Online Help” (with a blank 

document open). Software companies are increasingly using their Help 
programs—rather than paper-based documentation—to train users and assist 
in answering questions. Make sure all help files are installed.

c
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GET ACQUAINTED WITH USING HELP:

 1.  Start Excel and click the Microsoft Office Excel Help button .

 2. In the search box, key get help and press Enter .

 3.  From the list of topics, find a topic that will explain how to use help 
and click it. Click Show All.

 4. Read the information and close the Help window.

Lesson Summary

Excel opens with a blank workbook and the Ribbon. The active 
command tab on the Ribbon changes depending on what you are doing.

A new workbook opens with three worksheets. A worksheet is an 
individual page or tab in the workbook.

Press �  and �  to move between worksheets in a 
workbook.

Worksheets are divided into cells, which are the intersections of rows 
and columns. The location of the cell is its address (also called its cell 
reference).

Move the pointer to a specific cell with the Go To command or by 
clicking the cell.

The active cell is outlined with a black border. It is ready to accept new 
data or a formula or to be edited.

The Name Box shows the address of the active cell. You can also use it 
to change the active cell.

If you use the scroll box or arrows to reposition the worksheet on the 
screen, the active cell does not change.

The Zoom size controls how much of the worksheet you can see at once.

Replace any entry in a cell by clicking the cell and keying new data. Edit 
long or complicated cell data rather than rekeying it.

The Undo button  and the Redo button  both have history 
arrows so that you can undo or redo multiple commands at once.

Preview your worksheet or the entire workbook before printing it. To 
preview and print all the worksheets in a workbook, click the Microsoft 
Office Button and choose Print. Then choose Entire workbook.

•

•

•

•

•

•

•

•

•

•

•

•

1

Encourage students to 
use the Lesson Summary 
to review the important 
concepts in this lesson.



LESSON 1 Command Summary

Feature Button Task Path Keyboard

Collapse ribbon   Ctrl � F1

Clear cell contents  Home, Editing, Clear, Clear Contents Delete

Close workbook  Microsoft Office, Close Ctrl �W

   or Ctrl � F4

Exit Excel  Microsoft Office, Exit Excel Alt � F4

Full Screen  View, Workbook Views, Full Screen

Go To  Home, Editing, Find & Select, Go To Ctrl � G  or F5

KeyTips   Alt  or F10

Normal View  View, Workbook Views, Normal

Open workbook  Microsoft Office, Open Ctrl � O

Page Layout View  View, Workbook Views, Page 
  Layout View

Print  Microsoft Office, Print Ctrl � P

Print Preview  Microsoft Office, Print, Print Preview

Redo   Ctrl � Y  or F4

Save As  Microsoft Office, Save As F12  or Alt � F2

Undo   Ctrl � Z  or 
   Alt � Backspace

Zoom In  

Zoom Out  

Zoom Size  View, Zoom
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Point out that the Command Summary lists a variety of ways to accomplish a specific task. Students can 
decide which method they prefer to use for a specific purpose.



True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

 1. A worksheet contains at least one workbook.

 2. The Name Box shows the address of the active cell.

 3. The Zoom size for a particular worksheet is permanent.

 4. You can use the scroll bars to move the pointer to a specific cell.

 5. You can replace a cell’s contents by clicking the cell and keying new 
data.

 6. You must use Windows Explorer to create a new folder.

 7. Edit mode starts when you press .

 8. If you click the Print button  while viewing a sheet in print preview, all 
worksheets in a workbook are printed.

Short Answer Questions
Write the correct answer in the space provided.

 1. What is the name for the cell with a heavy black border that is ready to 

accept new data or a formula?

 The active cell                                                                                                                

 2. Give an example of a cell address in the first column of a worksheet.

 A1, A2, A5, A26, etc.                                                                                           

 3. What is the screen element that contains command tabs?

 The Ribbon                                                                                                                      

 4. What command enables you to use a different filename for a workbook 

as it is saved?

 Save As                                                                                                                          

 5. What is the keyboard shortcut to move the pointer to cell A1?

                                                                                                                              

Concepts Review

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 
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CLOSE
Concepts Review:
Allows students to check 
their understanding.

TEST BANK
Consider using the Test Bank 
to provide an additional review 
of lesson concepts. It may also 
be used as an assessment 
tool.

TEST BANK

CLOSE

Ctrl � Home
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 6. Which part of the Excel screen shows the contents of the active cell?

 The formula bar                                                                                                                

 7. How do you print all three sheets in a workbook with one command?

  Click Microsoft Office Button and choose Print or press Ctrl � P . Choose
 Entire Workbook.                                                                                                                   

 8. What do you use to reposition the worksheet on the screen without 

changing the location of the active cell?

 The scroll bars or the scroll box                                                                             

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. You can replace or edit cell contents. Discuss when you might use each 
procedure.

 2. Why should you use folders for organizing your files? Give examples of 
folder names that might be used in an auto dealership’s office.

Skills Review

Exercise 1-18
Start Excel and navigate in a workbook.

 1.  Start Excel and navigate in a workbook by following 
these steps:

 a.  Turn on the computer and start Excel.

 b.  Press �  two times. Which sheet is 
active?

 c.   Drag the scroll box on the vertical scroll bar to the 
bottom of the scroll bar. What is the last row shown 
on the worksheet?

 d.  Press �  two times. Which sheet is 
active?

 e.  Press �  and key a35. Press . What 
appears in the Name Box?

 f. Press . What is the active cell?

 g. Press � . What is the active cell?

NOTE

Prepare your answers to questions in the 
Skills Review exercises as instructed for 
submission to your instructor. Include 

your name, the exercise number, and the 
question number.

NOTE

If Excel is already running, press Ctrl � N  
to start a new workbook.

Exercise 1-18:
Objectives: 1, 2
Solution Files: None

Skills Review Exercises:
Provides guided practice 
for students. Objectives are 
indicated for each exercise.

Review how to 
maximize and 
restore windows.

Critical Thinking Questions:
Answers will vary based 
on students’ preferences, 
observations, experiences, 
and research.



 h. Press � . What is the active cell?

 i.  Press � , key d15, and press . Press �

. What is the active cell?

 j.  Press . What is the KeyTip for the Formulas tab? 
Press .

 k. Press � . What has happened?

 l. Press �  again.

 m.  Click the Close button . Do not save the workbook if a message 
box appears.

Exercise 1-19
Open a workbook. Edit a worksheet.

 1. Open a workbook by following these steps:

 a.  Click the Microsoft Office Button  and choose 
Open.

 b.  Choose the drive and folder according to your 
instructor’s directions.

 c. Find MarAdv and double-click it.

 2. Edit a worksheet by following these steps:

 a.  Press � , key b5, and press .

 b.  Key 2000 and press . What is the new total for 
the Bremerton store?

 c.  Click cell D10 and press . What is the total for 
this week?

 d.  Click the arrow next to the Undo button . What 
are the first two tasks listed?

 e.  Press .

 f.  Click the Close Window button . Choose No to 
discard your changes.

Exercise 1-20
Edit a worksheet. Manage files.

 1. Open MarAdv.

 2. Edit a workbook by following these steps:

 a.  Click cell A2 and press F2 . What is the current mode for your 
worksheet?

NOTE

This worksheet has an icon set, a 
conditional format. Values equal to or 

greater than 50 have a green circle; others 
have a yellow circle.

NOTE

Prepare your answers to questions in the 
Skills Review exercises as instructed for 
submission to your instructor. Include 

your name, the exercise number, and the 
question number.
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NOTE

When there is no data on a worksheet, 
Ctrl � End  goes to cell A1.

Exercise 1-19:
Objectives: 3, 4
Required Files: 
MarAdv
Solution Files: None

Exercise 1-20:
Objectives: 3, 4, 5
Required Files: 
MarAdv
Solution Files: 
Sol1-20 on 
Instructor Disk

Answers to Exercise 1-18:
1b: Sheet3
1c: Row 25-35 (depends on 
screen resolution)
1d: Sheet1
1e: A35
1f: B35
1g: A35
1h: A1
1i: A1
1j: M
1k: The ribbon is collapsed.

Icon sets are part 
of the conditional 
formatting options. 
Students will learn 
how to set them soon.

Tell students that 
the new total 
is recalculated 
because cell F5 has 
a formula.

4

Answers to 
Exercise 1-19:
2b: 2,220
2c: 300
2d: Clear; Typing 
“2000” in B5

4
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b.  Double-click “March” and key April. Press . What is 
the active cell?

c.  Double-click cell A11. How can you select or highlight 
the word “California”?

d. Delete “California.” Delete the space before “W.”

  e. What key will finish your editing in cell A11?

 3. Manage files by following these steps:

 a.  Click the Microsoft Office Button  and choose Save As. What 
folder appears in the navigation line?

 b.  Set the folder to [your initials]Lesson1. Where is this folder located?

     c.  In the File name box, make sure the original name is 
highlighted. If it is not, select the filename.

    d. Key [your initials]1-20 and press .

    e. What filename appears in the title bar?

4. Click the Close Window button .

Exercise 1-21
Edit cells. Print a worksheet.
1. Open MarAdv.

2.  Press . Set the Save in folder to [your 
initials]Lesson1.

3.  In the File name box, select the filename. Key [your 
initials]1-21 and press .

4. Edit cells by following these steps:

 a. Click cell A2 and press .

 b. Double-click “March” and key May. Press .

 c. Double-click cell A11. Double-click “California.”

 d. Key Washington and press .

 e.  Click cell F1. Key your first and your last name and press .

 5. Print a worksheet by following these steps:

 a.  Click the Microsoft Office Button  and hover over Print.

 b. Choose Print Preview.

 c.  Point near the main heading and click. Point anywhere and click again.

 d.  Click the Print button . Click OK in the dialog box.

 6. Click the Close Window button .

 7. Choose Yes to save changes.

TIP

Click or double-click to select a filename 
with no spaces.

REVIEW

The Mini toolbar will appear when 
you select text for editing.

TIP

 F12  is the keyboard shortcut for File, 
Save As.

Answers to Exercise 1-20:
2a: Edit mode   2b: A3
2c: Double-click it   

2e: Enter , Tab , Shift � Tab

3a: Varies by classroom  3b: Varies by 
classroom  3e: [initials]1-20

Exercise 1-21:
Objectives: 3, 4, 5, 6
Required Files: MarAdv
Solution Files: Sol1-21 on 
Instructor Disk



Lesson Applications

Exercise 1-22 
Open a workbook. Edit and print a worksheet.

 1. Open JanIceCream.

 2. Edit cell A2 to show the current month.

 3.  Change the first week total for Modesto to 15500.

 4.  Key your first and your last name in cell A20. Press 
� .

 5.  Save the workbook as [your initials]1-22 in your 
Lesson 1 folder.      

 6.  Prepare and submit your work. Close the workbook.

Exercise 1-23
Open a workbook. Edit a worksheet. Print a worksheet.

 1. Open BarSales.

 2.  Without changing the en dash (–), edit cell B4 to show 
2006–2008.

 3. Change the fourth quarter amount for 2007 to 55000.

 4.  Key your first and your last name in cell A14. Press 
� .

 5.  Save the workbook as [your initials]1-23 in your 
Lesson 1 folder.

 6.  Prepare and submit your work. Close the workbook.

REVIEW

Set the Zoom size so that you can 
see as much of the data as possible.

NOTE

Numbers align at the right edge of a cell; 
text aligns at the left edge. You may see 
green triangles in cells C11 and D11 to 

mark formula errors.

NOTE

This sheet uses separator rows and 
columns with borders.

TIP

You do not need to key commas in 
this worksheet. They are part of the 

formatting.
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ASSESS
Lesson Applications:
Provides independent 
practice for students 
and may be used for 
assessment. Objectives 
are indicated for each 
exercise.

Exercise 1-22:
Objectives: 3, 4, 5, 6
Required Files: JanIceCream
Solution Files: Sol1-22 on 
Instructor Disk.

Students may notice that the 
cell contents do not appear 
to be in cell B4. These labels 
have Centering Across 
Selection applied.

Exercise 1-23:
Objectives: 3, 4, 5, 6
Required Files: 
BarSales
Solution Files: Sol1-23 
on Instructor Disk

Encourage students 
to edit cells rather 
than rekeying data.

Inform students how they 
should submit work to 
you—by print copy, the 
Excel file, an XPS file, or a 
PDF file. The exercises tell 
them only to submit their 
work.



Exercise 1-24
Open and edit a workbook. Print a workbook.

 1.  Open JuneIceCream. This worksheet has data bars, 
another type of conditional format.

 2.  In cell F1 on the WeeklySales sheet, key your first and 
last name. Press � .

 3.  In cell B18 on the Owners sheet, key your first and last 
name. Press � .

 4.  Press �  and select the option to print the entire 
workbook. Preview the workbook before printing it.

 5.  Save the workbook as [your initials]1-24 in your 
Lesson 1 folder.

 6. Prepare and submit your work. Close the workbook.

Exercise 1-25 Challenge Yourself
Open a workbook. Edit worksheets. Print a workbook.

 1. Open JanIceCream.

 2.  On the WeeklySales sheet, change the values for the 
first week as shown here.

 3.  In cell E1, key Prepared by [your first and last name].
Press � . Preview and print the sheet.

 4.  On the Owners sheet, key your first and last name in cell C1. Press
� . Preview and print the sheet.

 5. Save the workbook as [your initials]1-25 in your Lesson 1 folder.

 6. Prepare and submit your work. Close the workbook.

NOTE

The chart shows shades of gray for the 
bars on a non-color printer.

Figure 1-17
A B

 4 Anderson 12000
 5 Auburn 14000
 6 Chico 12000
 7 Eureka 18000
 8 Fairfield 15000
 9 Modesto 16000
10 Red Bluff 11000
11 Redwood City 16000
12 Salinas 26000
13 San Francisco, 15th 24000
14 San Francisco, Lombard 24000
15 San Francisco, West [Do not change]
16 Santa Rosa 19000
17 Watsonville 16000

TIP

It is good practice to position the pointer 
at cell A1 before saving so the worksheet 

opens with that cell as the active cell.

TIP

Start in cell B4 and press Enter  to key the 
values down a column.
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Exercise 1-24:
Objectives: 3, 4, 5, 6
Required Files: JuneIceCream
Solution Files: Sol1-24 on Instructor Disk

Exercise 1-25:
Objectives: 3, 4, 5, 6
Required Files: JanIceCream
Solution Files: Sol1-25 on Instructor Disk

Conditional formatting now 
includes data visualizations. 
They are data bars, color 
scales, and icon sets.



On Your Own
In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 1-26 
Open JuneIceCream. On the WeeklySales sheet, practice each of the 
navigation shortcuts shown in Table 1-2. On the Owners sheet, change each 
owner’s name to someone you know. Include your own name as one of the 
owners. Print this worksheet. Save the workbook as  [your initials]1-26 in 
your Lesson 1 folder. Prepare and submit your work. Close the workbook.

Exercise 1-27 
Open MarAdv. Change the month to this month. Using the Internet or a 
map, change each city to a different city in your state. Change other labels 
to specify your state, too. Key your first and last name in cell A14. Save the 
workbook as [your initials]1-27 in your Lesson 1 folder. Prepare and submit 
your work.

Exercise 1-28
In the Open dialog box, experiment changing the views. Select and highlight 
the filename of each of the workbooks you used in this lesson (BarSales, 
JanIceCream, JuneIceCream, and MarAdv). Which of these files does not 
have a thumbnail preview? In the Excel Help system, look up document 
properties. Then open the Lesson 1 file(s) without a thumbnail and resave 
them with that property in your folder.
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On Your Own Exercises:
These exercises are entirely free-
form and do not provide steps 
or suggestions. No solutions are 
provided. Encourage students to 
be creative. You might assign some 
exercises as group projects. Some 
exercises might be appropriate for 
inclusion in a student’s portfolio.

Exercise 1-27:
Objectives: 3, 4, 5, 6
Required Files: MarAdv

Exercise 1-26:
Objectives: 1, 2
Required Files: JuneIceCream

Exercise 1-28:
Objectives: 5
Required Files: BarSales, 
JanIceCream, JuneIceCream, MarAdv




